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ABSTRACT

This development project is the application of object-oriented system development
approach into the mimic plotter. The mimic plotter is a less complexity embedded system that can
plot English alphabets and numbers. The plotter control system is also developed for controlling
the mimic plotter via Bluetooth. Lego Mindstorm NXT is used as the hardware of mimic plotter
and Lejos package is used to develop Lego Mindstorm NXT with java. This development project
aims to be the sample approach for embedded system development with the application of object-

oriented system development by using a UML in the future.
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dundeunisuen deynsegminduozdeesniiundumesidaidiguesndunas
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wya TnofiTugafleddusmimdhitlunsdszuranamsiiudi q Tasiigunsalfidu
a a g o y ] {
dumeSidwdunarerdyauaz Tugaflsnfuauilezgamuguintsdiuniugerduisves

seUUReA dega 2.1
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3‘1]‘?1 2.1 Tnssade lnodawilvosssuuileda (Japan System House Association. 2549.

=) ~ o o o
uﬂauaznsumsuﬂﬂu AT.FUITAU HTITUUA : 6)

2.1.2 dauthszneumemusisana’

daulszaeumeiuasauasvesszuuileiinzuandredulimumsissgnd 19w
sm'wﬂsznau"hJﬁ'wiﬂﬂa%’wﬁugmuﬁmﬁmﬁu Ao daululasnoufiiines
(Microcomputer) @n10lulsznouidre wiolssuananieduiiy MPU:  micro-
processing unif)  MUIEANUST (Memory) WOIABUNAABINHANUTIM (basic O) Faas
fAanefuriumata (BUS) uasdinmsigeudelulasnoufiuneifuginsalniousnrinms
Sumediny (nterface) Fovimihiilumsuasdaygna ey lugduvuimuzaudenis 19
- uasmshauveudufiy Wy msdiuimaznm mssanmsmanisaifidwnnanae

fosdeyanas iudu Fe310% 2.2 Japan System House Association. 2549: 89)

davdrznavlalarnaufiomed

> P Fumndivia niundeu 1

fumefirn

Funefina

[

o
funsnidesmmmounu

X
Bunmivugu
-
LRI, o

dayaidn gunzalieninm

winemu { ROM
o RAM

- 47 4 4 o
311 2.2 aorilasnssuugumeduasauasvosszuuileda (Japan System House

Association. 2549. WauazSouisueTas as.5ursa F3ziiung : 89)



2.1.2.1 1837ig)
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pufigduiilindnlunisiieuvedlulasneuiuned faindinlunis
o o o ' a o ° a

Uszanamamdauazatugumsthauan q Tasdndududuiigeziinsiinlassuninns
1 ' b 4 3 t 4
81UMFS (Fetch) 1&21%10158A1WAIAS (Decode) 9nTUTIHA AT (Execute) UoNIINT
daorefimsiaunuy Ti e (Pipeline) fiv Msdszunananats q mdeluwfeusudegii
2.3 Taodufigannsoutalnseadramelulaiiu 2 Ussianndn q Ae CISC uag RISC (Japan

System House Association. 2549: 92)

3
o

1. CISC (Complex Instruction Set Computer) 1ﬂu1§nﬁgﬁaaﬂuwm‘1ﬁ'ﬁﬁm N

Tumsiraungud

puduauun e Wannsaneuaussiuaudesms Tusunsuiledou
4 q finnududeugs anudvesdyaaunminaiegn wozgunsaddonionawd
18Tnons e ideeinsdmnas

2. RISC (Reduced Instruction Set Computing) gﬂaammunﬂﬁ'ﬁﬁﬁ'" SER T}
Fou Tnseadralidudou 198 1ded0q e ldseunanaldedesiaia musnldsy

v a dAa e 3 o o 9q ska ¢
Elluillnmu‘lemJﬂ'JHmQQVIﬂ ﬂ‘li‘VlN‘l‘NﬁJﬂgﬂﬂﬂﬂlmﬂuﬂﬁi‘lﬁ%ﬁmﬂiﬂ'ltﬂu

fiauninsadin
— vl
FrmeaiTmrnem 'g 'ﬁ "
samrrunal z
b3
| ] LN
sraidnany D @
LRm hinArdshmy
F— Mwaasdesm
LAALNIA
¥eani
i amdhamans MPU [
SN—— _‘___/

X o o
311 2.3 Mo aduily Japan System House Association. 2549. titlauazi5oui5u

o @
Tay a3.5u15AY T523/UAT : 92)

2.1.2.2 nHEA NN

mizsanuduiududmiufusdauasdoyada q Tasseifudeyalusy
FauaugIued (Binary) Feitnedygnamlifiniues dwmumsfiudeyasziftusududy
nquiadoya iy 8 da saududiu 1 lud dudu wazdnrssimuadumisiiogdeya

1 } 4
(Address) 1o 1¥81989lunmsi@ounsesudeyariu vursanudwaialdidu 2 Uszian Ae



NUIwAWT1500 (ROM: Read Only Memory) UaZLi5y (RAM: Random Access Memory) fid
gﬂﬁ 2.4 (Japan System House Association. 2549: 97)

1. sou Humizsanuiidquauianie e doyass Taively Inuud 1
1389 (non-volatile) ﬁ'aﬁusauﬁmﬁuﬁtﬁuTﬂsuﬂsuéué’fuﬁ‘axgmguﬁgémxﬂﬂﬂLﬁ"aﬁmm
frdvazsudumsihoundnniidmsoeldidrszuy ﬁ?ﬂﬂsuﬂsuf:ﬂxgﬂﬁunﬁmudau
e Tnaaldsunsy Taowaluseuntia 18 2 Uszinnndn 9 Ao mask ROM Fufluseud
Qm%uufh"l”a’(s"uvf’fuﬁymdi‘fuﬂaumswﬁﬂ (a2 EPROM(Erasable Programmable Read-Only
Memory)  tHusouiszifoudoyadhnmendmieannsoay’ld venvinil EPROM &
annsoutsI8iursznne q 18ud uv-ProM  Husenitannsoaudeyaldiemsare
wassansrlaletnanday3 (UV) Az EEPROM Huseuiiaunsoouniedvudeyadly
Tnaidae v

2. sy dhumisanudificmsa@ounies 'y uadeyaszmiuile s
mss1ell (Volatile)  Buitgazinulaafuniedouiuavesdandsildnuniody
Tiesdwmsududsniedeyadiey Fevunaezdosbitdnlndwuedisufiudmiunisld
a Taowa lusuurie 18w 2 Uszian fie SRAM (Static Random Access Memory) LAy
DRAM (Dynamic Random Access Memory) Tﬂﬂﬁ SRAM Li‘luusuﬁﬂsznamﬂmwsﬂﬁﬂ
Wasdviamdieanudige deuniwuunissanuiwuuuny(Cache memory) dau
pRAM dhusuiifimsfudeyafidesfimaimlssRefresh) ioldoyadnsed musaataa

] ° ] 1 - t
TWdumissanuinivinalng 18 uannuslunmsdhdeezdniuwy SRAM

FudegafDupluuuniinin ¥in mask

ROM wimusinulignsoudloyiungld
mask ROM

Y
susyalinzemsliis
snafililaion sunsodauiuln

oo

fayslineudlviy

E?kw avdagslilacidlah

EPROM
g guumoudinlieuudeeld

EQ~ Auginsdfiiudgenn EEprOM

nis

murdh
RAM
SRAM | ufayslurfusissiamufage

—dldaudayafeewn

DRAN | Rudagalukaifuirydsdmifil

317 2.4 M3uria)) sEnMNUIAWST Japan System House Association. 2549. tlauas

]
Y

o4 = o da
LitJ‘UtSUQTﬂU AT.FUIAU FITUUAY : 98)



2.1.2.3 U _

Ta(Bus) fio WunnmsAadedomsszniedoyn smnsoutamudiunis
mslFauldidu 2 dseinnndn q 18un Fan1olu dntemal Bus) Wunquuesdaa o
TuTnsnouInsamesflFimsudmsudeindeoyasesniadufiy missanus Suwas
l01AnA nazdaniouen  (Extemal Bus) ifunguussmedyaaiilddedeyaszning
Tulnsneufamesuazginsalnsusnais q Yaude 18l 3 Uszinnndn 9 1un (Japan
System House Association. 2549: 95)

1. wemAs L (Address bus) Wdmsuseydumislumssudsdoya

2. ATt (Data bus) I¥dmiunannldeudeya

3. nva Insaia (Control bus) s muanazaugy usawmsatiaazaid

2.1.2.4 gilnsaldunauazier1dnanugIy
v & 4 a ~t @ 1.9 9
Tuszuudedniupuigesiinisfuaideyaninneusmdmilszuiana.
' PN 1 = S o gy =§ 9 ' S A o J
nouflszdeven lumeouendnass dniuezdesiimsuandsudeyassnuduiigiuginsel
' a Jd & J a
MIUBNHIUNIBUIRBSN WO interface) Feginsainmeusnisznoudiegilnsalduyauay

Ql] g aﬂmﬁwm (Japan System House Association. 2549: 113)
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da 1 (Y
gunseldunafugiu iudiufudeyauasdyyradieg voq

g 0O

- o

a 1 an o =3
luTnsaouiiuned Tavszdedeyalugivesdoyaniaealdfuduiigienlllszunana
o 1 a J v Cs { o { 1Y '
Taeia 15031 Bunanesa Tasduglnsainiedses Idfuiedmdhiudasdygnulieg
a T a ¢ a 1
TugtupumnzauiSendn 29esdumesinla (Interface circuit) g1nsalduNATU IBUITDS
(Sensor) Wudu
s Jg 4’!’ ] LY s a
gnssliodnaiugnuilutemissentesdyanaiifinainnisdszurana
d a a ¥ aa ¥ o P ~t v
voudufigTassziinmsulasdoyauvudasalfidudygranemon iz ausoni

o

o ¢ & [} o o A o d a d o
PIANANDIA cvmflumumﬂﬂﬂumit‘m‘)ilms‘mam‘vmtauwmuaﬂﬂimmuuﬂﬂ Q'l.lﬂiﬂnl

u q

1" v @ 4 1 d
1A% 1aun daduindou (Actuator) 13uNBIABS veudAIHA UL

2.1.3 daulszasumamuverlduad
dautlsznovvesrorduds Taoia lauy1didu 2 dszianing q fie szuu

ﬂﬁﬁami (Operating system) waz Tdsunsuyls zqmﬁ'\' (application program) ﬁﬁgﬂﬁ 2.5
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zﬂﬁ 2.5 ’d":luﬂ5$ﬂ81J‘UG\1°]5EM¢7LL'J§(Japan System House Association. 2549,

o d o
wlanaziSouseelas as.5U158Y Svalung : 95)

2.1.3.1 szuul Guinnms
a wa 1 g { o { o ¥
supifiansiudiuvesserdurfszuuiviinihidudinaresening
/o & ¢ ¢g i o
g1sauasuaz Tlsunsulszgndiall vnenfeenadlu@sunnsald fudhiindng fems
o o 4 g9 a ¢S 2 e o 1 (-
tarsininensluszuume lduTmsgenduridseygnd arugumssudwazsanudeya
14 ) b4 (]
Jagssuiiniasarud sauisdmihisaassnarlunisdszutana seuudjiams
* d a a 4 . . .
sznoudlumnesiua (Kernel) UaAaLIs (Middleware) 110y a'lad lasies (Devices Driver)
J A o Y A Yo a d o dy
mesiua uluganarsfinindiilunsIddudafeadsuiugiuves
a wva 9o a o o [ as A 9/ d A 1
sruudfiams Tdulafledduresmsiamyenuuuudumdeudiomgnisal Soah
¢ ¢ ) o . . <
Sva'lnlinosiua(Real-time kemel) n3oi5uaIniiToioa (Real-time Operating System) @ardiu
1 Y d o dy o Y a - J ° o Jd
dmivayuilangunug AnldfemsdszuiamaunuuiGea nd ssdinundnveunes
J o o ° Y A o I a :3 9
wavzyszneylUde Auddumsianseauimibhilumsdansmgmsanifatunden
Y U4 d o a I ° { o
funa1e q mgmisel MFunIuMIBUMesTH (nterrupt) Hmthfidanisuazqua
a Ju  Jd a :5 v Jdo a o o Y o
sunesinaniavumuaazlszinn uasandugmAunea (System call) Mmiifivams

msisenlduTmseinszun degiil 2.6
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317 2.6 AeFumsianundnvesnesiva (Japan System House Association. 2549,

o d @
wlanazSousealas as. U5 55230UAS : 96)

a a Y do o { o
fiadaurd Hulugaiafuayuilsdduiallvesssuy vindidudanars
o a . v Y o o o 1 4 o
Hudaszauuinis(Service) a199 Wdunenndindulasiuniunesivainiugunis
° a wa ° yvq 3 a & 1 Y] 3 & Y
Mamvesszuud§ians iR lFaunenndinduaieg ldazainiiu Fernlsznoudae
4 ] d o 4
Taus3 (Library) i¥uszuyInd Asdduaruguatsfeas dudu
4 [} a 4 a o
aldlafned Wudusuguainsaldunaneidya eldifaflassulu
1 4
[y 1 o J [ 1 a
msfudedeyatuTdsunsuilszgnd unasuSendiszuuniuguiunae iy (nput &
a wa o (4 1 P
Output Control System - I0CS) seuuUfaians Taeialud 1 lasneseeliudiuniiaves
a wa 3 d [ n’: ' [y a o
seundfiants  uadulusedduadsruuiedniuszunnameiuldmundasust uazns 1y
1 4
LYY v o o
augdnsal Fufuidldawsaldfedduvesdladlasnefunummwizinizesaslyly
a wa Y ' o) a o Jd’l‘ [ ' o @ .
seuulfianis 14 daulngjesliifiesdlid lasnesAugiundn 9 15u #28u19a1 (timer)
a a . ) o 4 A :
SumosawiindiFoa (Seral VF) Wudu dmivudlalasiesdu q fusisszdeminin

¢ oA Aa A [ o 1 o J d Y o =
yordsouniiog visendesianuniiunies Tavhld lasines flasead1edsgiii 2.7
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317 2.7 Tnseadrevesdlad lasiied (Japan System House Association. 2549,

[y s Q'I
wlanazBeuSealas as.sursar T32uAs : 97)

2.1.3.2 NWsupsaalszgnd

d d 4 o 1
Tusunsuissgadidusendurinldfuauiuaeio q  awanudesns
[ 1 4
vosfldnannsaiunldlse Tomi1dTaoase ildmsihauldazainiu  nieomdiu
v 1 4 ]
gordus Iamuanzd s fdudfaniueuie Wminzaudurammsinuvesau

v ' 4 Y- t
amsouisrenduailszgndesndiuaesnguiie serduriduiegy Ae Tsunsudignate

¥ =1 4 o ] @ ]
nsaouduunadvSouioouds wieuneeiil1diua1eq18%uf WU Microsoft Office

¢ o ' s ¢ o @
Wudu wazwerduariflFoummediu wu gevdurfilssuranad sendindszuuind

Audu

g ¢
2.2 NavAIADI

d A A Y o Y o o
NWADRIADIAND ATDINAVULTU TIN‘INIﬂUE)‘IﬁEJLL‘Uu%‘U‘JJ'Iﬂm ammumuiuuummu

@ W

1 (Y 14 a q
XY vunssay wuiRedfumslisuds hnnmseaude TasndsameseeTudayanann

A

A o ¢ A ay 4 4 a4 4
n3oenounnes tioldniugunisieuthnmlduunszamdsmusaidend nielnm f
v < ™ ¢  oa ° ' o
fidunuruiseste1sn 14 ludlvgtuiisevdursiaunsademswiunionned uazuaas
i : aa an v [ Qs £
mnmdusia 2 Thuaz 3 5814 uadoiFevss wiomned ane Seldaruulunisarenin
(UVM1INYIDINIEN. 2548)
naoamesutennlanlu 3 Uszinn fie
< o P=% ' 9 Ao
1. WADAIMBTUUUNTINTZUDN (Drum Plotter) 3¢HU1NNUINATT 1 F1undivuiauag
I o 4 4 A L=
nawd ndadundeuii liunuunszay moldmsauguueuniesnsufiunefifte

o 2 ' A P [ Y A1 o
AIWNTHUIUU ‘lJ‘lﬂmLmSLm\ﬁ’fNﬂizﬂ‘IHﬂstﬂﬁﬂu‘ﬂvlﬂ‘wmu"] ﬂuiuuu‘)ﬂﬂ‘mﬂu
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2.3 ﬁﬂﬂﬂﬁﬂﬂi%ﬂﬂﬁﬂﬂ?!ﬁiﬂ NgaAIol JUIDUIBNDN

o ' o H o o { o
ganaaszuuilidae 18 snesaasey Juoudndh Jdulsznoudidey fdw 19l

i 4
=

msWauIHADAIADT Ay
<
2.3.1 1PUISNFN (NXT)
pudadidudauiviimihinlumsalugumanihouvesszuy Tasiiddaulseney

} 4
nane fsil

g‘lj‘ﬁ 2.10 1BUBNTH tazause ﬂEJ‘lJﬂ"N‘](http://www.active-robots.com/products/lego/

nxt-accessories.html)

- WoiN (Port) AmSuiBruNeIAd 1l 3 woinde 1o (A) T (B) uazd (©)

- wosndmudouiruses 1 4 wesn e 123 uas 4

- wosngiend (UsB) didsumogioaiiiedeudetuindomoniinaed oani
Tnan (Download) Tilsunsuaslumudngd

- d1lne

- fundugu dsznoulidae 4 u fe fudmdes imihiidanios iy uazidla
Tusunsy fudmsewimihiideudis va1 melunthoy taztludmuduimiiiosnsn
Yy

- VDUAAIND

daor s
2.3.2 1 UIBBTAUNT (Touch Sensor)
o o d 1 o a A o
s dude (U 2.11) Freldszuy awsefuifedefidwnnsenudussun 3

u130a33950 14 3 daue fe da1uzne dazddes uazan Iz (Bumped) Aegui 2.12
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T
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517 211 wwwe Sdudai 1dfugananesssuvilsdnal meaason JuouBnFH

(http://mindstorms.lego.com/eng/Overview/Touch_Sensor.aspx

-l e, e
&l &l &a
PRESSED RELEASED BUNPED )

ﬂﬁ 2.12 ﬁmu“mmuwaiauwfrma%w"lﬂ (http://mindstorms.lego.com/eng/Overview/

Touch_Sensor.aspx)

J
2.3.3 1 aIua (Light Sensor)
o d' A J s/ o
e suas (319 2.13) nsausnuszanuila uazauaineld TagnsIana
H [ ° [~ o 4 ] Py
Wuumaiazioussnvndunazd viliszsuuneuiudiiuuidg Tnefudasdunuaiouaei

fianuduuanaedu dawaaslugli 2.14

31l 213 wuwe Suneiildfugananosszuilidaun 1A modasey Jueudndd

(http://mindstorms.lego.com/eng/Overview/Light_Sensor.aspx)

This is what your eyes see This is what your rahot will see,
using the light sensaor.

gﬂﬁ 2.14 M3NBITUTVBUY DI (http://mindstorms.lego.com/eng/Overview/

Light_Sensor.aspx)
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311 2.15 wewesvesganaassszuuildae 1A weaason JuewdnTi

(http://www.g9toengineering.com/summerschool/I.egomindstorms.htm)

d
2.4 12999 [2UIBNID (1eJOS NXJ)
@von toudndiy Wuanminadeulumsiannganaasuald oaason fuiou
~ @ @ A
Badd IWgRannmusalinmmemlunmsweann1d Falseneu1uds (Paul Andrews. et al.

2006)

st At o a

4 4 o o
- Msuuas (Firmware) TINSUDUBNTN NUNTITTINDINIT IDTYID LUFY

(Java Virtual Machine) W lUdae

o @ A ™ d da
- gamdanyaslumsimu T sunsuvesouBngi
A A A a o 4 d Ja
- Sesdenmslumsnasuiisusve e U NFN

¥ H
@ -

- gamdeimsiumsdannTdsunsuvensuiunesisielidadefumeu
g Jdar - 4
PagfRIuNIugys 14
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= & o d a o g
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afuayuMsHAIIAILN Y191
o o 1 a
- eldsredn s fuveaa s
8 1 L)
- ANATENIURNUBIALS IRBd LU
- advayumshnuuuuiaassa (Multithread)

a A '
- mueyumsiyeudedlougys lavauysel
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3.1 alﬂ51$ﬂﬂ?1ﬂﬂ§)\1ﬂ15‘uﬂﬂ'§$1ﬂ]
o o 7o d o a
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3.1.1 anunsimsidunihfindn (Functional Requirement)
v o P -] a
1. RlFeunsotlousdsnysidesnisnaenluneuiiunes
4 ' o g do
2. Aldawsaadrumsiouds lilfmasamessiansld
vq & & o 7o a ¢ 1
3. fldaunsadimandeamesiinesdroneniuneininszes lna iumsugys
o <0 a v o 299 9 Y v o
4. wismmeirassrunsolsudisnysmuiigladesns1d  Taoiduddnys
(3 v a [} o
MI8INUAINUN Ing) uazduaw
-] do v o '
5. wasameit1avsaITnleuUFISNYIUUNTTATNUALADY YU1A 10.5 x 29.7
FUANAT HATNTTANABINBIVIANTI 10.5 wufiuns 1§
-] o ' ' :
6. wasmaeiimesansansIvaeUInszawnuan’e i wiewnwdudoudld
HIUNSSEULMILRUNABAIRD S
3.1.2 anunesms kilvnihiindn (Non-Functional Requirement)

-] 4 9/ s/ ]
1. ssvvﬂ’mquwaaﬂmamsmﬂ‘mmqw
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3.2 MIINTITHIAZDAULUIIIAIIS
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10 ] 29 2
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(0,0) (6,0)

0,4) (6,4)

3N 3.9 drvgnndadatnys ‘A’
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3.3.3 ganalaozunsu (Use case diagram)
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g 1 I~ do g ] 1 1w W
Foamsnann Nwasawossaesauisonasa ldnse i 4110 1dvzude lins1u1828nus1a
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MD5910949
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3.34 ﬁ13§ﬂ1ﬂgﬁlﬂﬂ (Use case description)

1 Ay ga o S a A e e
uaazganaf IdAnsziuazesnuuiu invaziduadeae 1

m1319f 3.2 Sefuregmaansaiumsiyouse

Use Case Name: M3a3190151%0ud0 ID:1 [ Importance Level: High

Primary Actor: éml‘lsf’ Use Case Type: Function

Brief Description: iugamaafiviimifiafumsiseudougyssenitmioninedsined ias

d
SEULNIUGUNADAINDS

.. o do o =4 9 9
Pre-Condition: waﬂﬁlﬁ95%Tflﬂ\iiﬂiﬂillﬂﬁ“ﬁ(ﬁ]593]“@')

4 1 o
Post-Condition: M15iFoNABIATIEUYsal

Trigger: é"l‘i’f'ﬂﬂﬂil Connect

Relationships:

. vg ¥
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g J o A ' @ o1 1 4
1. 53‘11‘11m‘uquwaammasmmswama"lﬂmﬂqnuuum
g 3 o o 4 3
2. waammas”mammmsmmumitﬁ"?ama

g 4 '
3. STUUMIUUNABAMes AR IUEMsITRNABI T VALY el

Exceptional Conditions:

a1519 3.3 Sefueymnanistududeniu

Use Case Name: M158ufudoniny ID:2 | Importance Level: High

Primary Actor: éhl‘i’f' Use Case Type: Function

Brief Description: i{lugainafiimiifiasssaendennuiiflédosmsnien Imdeaned

3 -1 9 A ]
$1avemusonannlansely

o -]
Pre-Condition: § 19 1msilaszuvniugunaennes
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H I a e H
- lunsdindendnuligndes fldesdesiuidenimdnnss

4

b1
Ay y v ke Y o o d
- GlUﬂiﬂlTl‘Uﬂﬂ')'lugﬂﬂﬂQ VOANUUUITHIDUTINIUNITINADA

Trigger: m‘ff'ﬂﬂﬂu Confirm

Relationships:

VIR
Association: Fﬂﬂf
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M31971 3.3 (AD)

Normal Flow of Events:

1. Alddendszimnszaiuid

o 1 A
DINITNADA (NTTATHTIIUANTBNTEATHADIN DY)
a g9 J 9/
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(-4
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° 9 1 9 v o P o ' [
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ansanaon ldnsely
9/ 9 Vv9q 9 P 9 9 v 9
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Vo W { o ° 1
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Exceptional Conditions;

Mm¥an 3.4 Sefuvgmaanisdindon

Use Case Name: 1154 nden ID: 3 | Importance Level: High

Primary Actor: é’fl‘l’f Use Case Type: Function

Brief Description: iugaaafivimiifilumsulasdennudisiumsasieaounds Wiy

o A d do 9 a’: ) 9 Q’: o -] g o
5ﬁﬁﬂwaﬂﬂm05ﬂ1a0\uﬂ11ﬂ %1ﬂ‘u‘u%8ﬂ~111i)ﬂ’3111uu"lﬂana‘i)mﬂaimam

Pre-Condition: 48A7149zABINIUNIIATI9TOLUED 11gNABS

Post-Condition: -
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Relationships:

. L. vq ¥
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Normal Flow of Events:

1. gi¥ndntf Send
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4, samﬁﬁf‘h§QLLazsﬁﬁﬁa€nysLnd11fuLﬂuﬁﬁqwﬁam

Vo o Qs ] o 1
5. demddllfmdemnessriantiuugys

Exceptional Conditions:
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M3 3.5 Sefuugmaanisnien

Use Case Name: 117 wion ID: 4 | Importance Level: High

Primary Actor: - Use Case Type: Function

]
= 1

A L. A o Ao g o ° Y A g 9
Brief Description: iugamaiiiinuiitlindemnsssiass imihilunmswdeadeninuid
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Normal Flow of Events:
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LY ] g .
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y 1 )
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° < LY a o
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I

° :, 4 ' o W
7. MFIVDN 4-5 IUNNWATUNNAIDNYT

a13190 3.6 Sefueydiadnisenidnnsnien

Use Case Name: M13UNANWADA ID:5 | Importance Level: High

Primary Actor: P:Jﬂ‘]si’ Use Case Type: Function

Brief Description: (fugaiaaiiiminlumssnidnmnienvemionmeiirans aui

Ao

-] ° ] 3
Pre-Condition: WapAAB3 $1a09d090gluszHINmInden

-] oo L P
Post-Condition: NaADAINDT mmﬂzagﬂ‘u’dnmziam’mmﬂizummfznwﬁﬂmma{
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f } [ewmm 0w ]

Chek Send (o send messaga to Platter @
[ ]
4

Click to cance! pint

Cancet plot

9

a g ¢
31.'71 4.1 HUANVTS VUM URUNODANDT
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Plotter Control System

Power by ',_-]ﬁ%mm-

Chick to connect to Plotter

9

2 Choose pager
@ Single Paper O Continous Paper

Type mesvage i texibox ihen ciick Confirm

I

&

Click Sond 1o tend mossape to Plofier

3

@

Status

14:36:38:; Connecting to NXT...
14:36:41; Connected

14:51:39%: Chacking message...
14:51:39; Confirm message complated.

Clck i cancel plot

Cancel pict

4 o & o o o
310 4.7 wadwindenndududeanuduse

Ay )
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luns@ifdonnulididnys liawrsondenld szuvssuaasdonuuduioudld

H ¥ o VI < o a & = v H
wiousiaszydadnushi hiawisonden’ld AsgUi 4.8 Fefldezdesiuvidoniuinidnnss

" Y " ¥
(SUMMUTUADUN 4 DAASY)

Plotter Cavirol System

Pover by '.J}.'.‘."ém--

Chcl to connect 1o Plotter

'

X

Choosa peper

@ Single Paper © Coniinous Paper

Type mossage ivtexdbax then click Condinn

! | | B ||, onwr |

&

Chick Send to send messags to Plofier

3
[ ]

7

14:54:29: Connecting to NXT...
14:54:32: Connected

14:54:45. Checking message..,

14:54:45: Your messape cannot be plot It
chauss these charactor.

i€

CHek 1o cancél plol

Cancel plot

3

U7 4.8 wodwiillodennuiidadnusiliamisanionld
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frdeanisud ludonrui 1douduliuds adntfu Clear naLTaSuiaudunoud
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2 o d 4 " o @ < o < 0 & o
5. aaniu Send A3l 4.9 Memsdemidindonlldmtoameidrass Fanden

do A g @ A3 ad d o Y1 9q Yo Y v Y
wes$1avnzEhimsnieniuil uslunsiinndenmessiasensisaenai 4l 11414
aszamfvzuansdenudoud gz 4.10 uazleldnsemwiSondesudq Inaljuddud

o 4 4 A o o
wdndi (Wagfl 4.11) Neisuhnisnasea

Platter Control System

t1e08
& § baum for LEGD Mindsheme:

Chick to connecl to Plotier Status

1 commect T457:16: Connecting to NXT... ~
¢ 9 14:§7:21: Connected

L 14:57:32: checking message...
14:57:32: Confim message complated.

2 Choose paper
B Single Paper O Continoun Paper

Type message in textbox then cBck Conftrrn a
l_ contrm || _Flear}
3 Click Seiid to send message (o Plotier @

Chick to cancal plot

Cancel plat

N 4.9 msﬂam,!u Send tiodsfds S amdonmesdiaes

e Out of paperlt
. Please insert paper and push yellow button.
Q

31 4.10 ndesdennuudafoudldindslildldnszay



wnanstduenansianuhdmiunislsnuiionisfnwimitu lweygslniluleyssloguaiunism

lunnsdilagnsdu Snvisnuiiludaudadilon waznotosdsiuaivaaenaisynasaninisiluly



45

Plotter Control System

Power by Jﬂ'-'vm-—

CTick to coismct to Plotter [ Status
t
1 o 14:57:18. Connecting to NXT... At
¢ 9 14:57:21: Connected
14:57:32: Checking messags...
L 14:52:32: Confirm messags completed,
o 15:01:33: Your message has been sent.
@ paper 15:01:36: Plotting '
Stngte Paper O Continous Paper 15:01:48: Plotting ‘s’
® © Pep 15:02:02; Plotting ‘2’
@ 15:02:15: Plotting '3
Tyns message I texitiox (hen click Confim 15.02:30: Plotting **
15.02:44; plotting ‘1"
| l [ Confim ] l Clea., I 15:02:56: Finished
. s

Click Sond o send mossags 1o Plotier The Plotting has been done.

’ ,

e

Chirk to cancel plol

ﬂﬁ 4.13 ﬂ']iuﬁﬂﬁﬂ')']uﬂﬂﬂu'm'lél’iﬂi]'lﬂWﬁﬂﬁmﬂimﬂ‘EN

=

7. lunsdiidennuend liifiu 6 A8nys szuvssudasndssfonnuen g 1431

QO

o o Y {
doamsnasnlvinsy 6 Monusniell dwaaslugili 4.14

There still has space'to pldt miore character in this'paper.
Do you want to piot another character?

@J Na.

51 4.14 uﬁmﬂaawammmamm’q"l%

Y 999y o ) ) & va oy a o a4
g lsdvenInasnns 1¥ney Yes daszuvezoyyinlnaundennudaass Tash

v ]
-

¥
SRS nEsARIFRNW IaTY szsaududennuauud ) liifu 6 #2805 lunsaindldly

AosmIndends Iiae No
4.12 miFandenuunszmudeiios
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f é‘l%’%zﬁ'mlﬁanﬂszmys&imﬁm‘lm‘fumuﬁ 2 Fagiliit 4.15 Sanszarpdediosamnsaiud
Joanu i hisfanamen wisameinsesiimsnsvaeunszaumnndifindondisnys
nilaq 1w3e Smuinszammuaiezuaasfomuududeudldfusuiindrinuds iefld
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Platter Control System

Power by JE“:IMII‘-

Cick 1o connact to Plotter Status

1 8 15:13:50: Connecting to NXT...
15:13:53: Connected

15:14:00" Checking messags...
15:14:01: Confirm message complsted.
2 Choose 15.14:06: Your message has been sent.

15:14:08: Plotting 't
® Single Paper Q Continous Paper

]

Type message in textbox then chick Confrm @

Click Send 1o ésid moessage ta Plotter @

3

pois

Chick 1o cancel plot

=2

$ 2 i o = 23
311 4.18 AdNYY Cancel tHDAWAIANMINADA

Plotter Contral System

Power by Jn‘ﬂ'&unﬁ-

CBek to commect to Plotter Status

1 6 15:13:50: Connecting to NXT.., ~
15:13:53: Connected

15.14:00: Checking messags...
15:14:01: Confirm message complated.

15:14:06: Your message has bean sent.
Chooas papes 15.14:08: Plotting ‘f
® Stngio P Cortinous Papor 15:14:20 Plotting 'S
epor O Pep 15:14:24: Sending cance! command...
@ 15:14:26: Cancel Completed
Type message in texthox then click Confirm

l ) (o (=]
,,,,,,,, ] RS

Chick Send !0 send message (o Plotter The Plotting has been canceled

? Sont x|

Ciick to cance! plat

! 4 ¢ 4 a
31 4.19 szuumvgundemmesuaasdeniosnidnmIndenduSe

a 4 a ¥ oa v a vy
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nnmMsianzd ludmmsivendedsugysseninssuuaiugunioanafunden
Jo A T a P a Y Y aa A
wosi1a0s Muyeuaeil lemanszifamsianisvosdyana’ld 3 nsdl fe delaszuu
g s & g dy o A ] 7o
AILAUNABAIADS IBsTULMILRUNIBAmesTadya Uyt uazilielandeaneTsiaeg
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Plotter Contral System

Power by Jﬂo-'mmun-

-t
Chick to connect to Piatter | status
1 r— i
17.30:40. Connecting to NXT.., 1
“ . ] 8 , 17:30:43; Connected ’
17:30:59: Connection losth
Ploase reconnect.
Choase paper
@ Single Paper O Continous Paper v
Type.message in texthox thes click Contl - -
P i ey e Lost ‘commection [rom Pictter.
J Co Pleage reconnect.
| COV—— - -
&=
3 Click Sond to eend messaps to Platier @
Sond
’ i

Chick to cancel plot

Canced plot

31 421 szvvumasdeninuudufioundsmsiseunegadana
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MARUIN N.

[

A v & d A d d
N1V B UID NI LD ‘U‘I-!TI-!TGITGT ONUYN

1. antf Inaa s T sunsuanny lad http://sourceforge.net/projects/lejos/files/lejos-
& 4
NXJ-win32/0.7.0beta/leJOS_NXJ_0.7-Setup.exe/download latTusunsunilunessu 0.7 &
fo A o Aq
WunefFuRefun 4 lulasems

4 g o eal o o 2 o {
2. dieaai TnamaSe Suivaf 1da1nl Tnasn simifundiniy Yes fagiii n.1

Install leJOS NXJ

] . ] -
310 n.1 wihaadietinisSulidaads
k4 [ 1 A ] } 4 1 4
Y a 1 @ al a $ 1o a o
3. mIntundniy Next fagil 0.2 ivesudgiunsunmsands

leJOS NXJ Setup . ” E3

Welcome to the InstallJammer Wizard for leJOS
NX3
This will install leJOS NXJ version 0.7 on your computer.

It is recommended that you close all other applications
before continuing,

Click Next to continue or Cancel to exit Setup.

¥
Y

H v k4
310 .2 mhaaSuddiunsumsiad
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° d { o . 24 a’: 1 a
4. fvualainneInan (Root directory) ¥0a 1150053 Fe T sunsuozdeninlSoe

14 o '
i1 C:\Program Files\leJOS NXJ 91miueniin Next #a31/4 n.3

leJOS NXJ Setup

Choose Destination Location

Where should leJOS NXJ be instafied?

Setup wil instal 18JOS NXJ in the Followiig Folder.

Toinstall to this folder, click Next. To Install to a differant folder, dick Browsa and select another
Folder.

No JOK Jnstalled
Destination Folder
e ——
InstallJammer

L.W [_concel ]
d' 9 1 o [ o
31U 0.3 mihdedmualasanesvdn

] 14 o
< o

0 [ o o 1 o a o {
5. tnualadnneidmiuTusndaedn siniundn Next fagUii n.4

le JOS NXJ Setup
Choose Projects Location

Where should leJOS NXJ projects be installed?

Setup willinstall leJOS NXJ projects in the Following Folder,

To install tothis folder, click Next, To installto a different Folder, dick Browse and.select another
*folder,

The default folder is C:{Documents and-SéttingsiEakileJOSNRXIProjects

Projects Folder
[t —
InstallJammer

« Back | i Cancel
L.w [concer ]

4 ' o < 4 o '
31 n.4 nidsdimualadanesuessTilswadaedis
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8 y 24
6. TUsunsufnAsazianissazidoaveImsfant minssazidendanaingndes aan

] ] y 1
1J3s Next tWoI50 M sAnA AU n.5

leJOS NXJ Setup

start Copying Files

Review settings before copying files

Setup has enough information to start copying the program Files.. If you wantto review or
change any settings, click Back. If you are satisfied with the settings, click Next to begin copying
files. - )

Install Directory: |
C:\Program Filesi}eJOS NXJ

Projects Directory: .,
C:\Documents and Settings\EakileJOSNX WProjects
Setup Type:
Typical
~|
L e m v irm s o 2l
Installdammer

| < Back I%I Cancel l

v 4
3 05 wihdudasseazideansfnde |

A o a n’: A a g d g 1 o ~
7. Tdsunsuszisuihnmsdads uaziieAndsduivzuanmdiniedagii n.e

1eJOS NXJ Setup X

InstallJammer Wizard Complete

The InstallJammer Wizard has successfully installed leJOS
MX3. Click Finish to exit the wizard.

When you click Finish, the firmware flash program titled
"Install NXJ Firrware in NXT" will run, Follow the
instructions on the screen and it will update the firmware
on your NXT to [eJO5 NXJ 0.7,

When you exit the firmware flash program, this setup
program will finish,

If the firmware flash program does not run, go to the bin
folder in your installation directory and run nxjflashg.bat.

{ ’ Cancel l

Y

- a : [ . d
3N 0.6 midaaasMIAnALES Ty el
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msmmawiwmamaa POUIDNYIT UUHIBDUIDNYN

o ¢ o g da < Y o a o a¢ ¢

1. lumswannseWAusuueUB N RmBURNnIRIB wrdeainsAadui suus

g ¢ a & a¢ ¢4 ' g R

Youav0d wunTeney TaslYsunsuAnduliunisye nxjflashgbat oglulasanesh

v v ¥ 1 4 0 ]
Andunvemer]3 luiilAnda 137 C:\Program Files\eJOS NXI\bin #9317 4.1
. |

e E@ Vew Favorkel Took Hep

O © B Lt Prin T ramoe

B rucpoibat | Type: M5-005 Bakch Fls
M5-D0S beteh 7| Date Modfied: £1/11/2008 3:37 PM
e Slzs: 270 bytes
P
Daprt e

a & oo P
SUNSURAAUNTUINT

] } 4 ] o "
2. diesu'ld nxjflashg.bat wTunIAg ﬁﬂgﬁﬁ v.2 AAN Start program Wos

A a & ae g
ﬁllﬂﬂﬂ\nﬁiﬂlni

v 3
310 w2 wihee Tsunsudadailfuind
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3 oy ¥ o A ' 1 3 oa o
3. mﬂuui]zu‘lli’)ﬂ'mm8ﬂ1ﬂﬂ1ﬂ15ﬂ58ﬂﬁ8 USB 53“31Ql8u18ﬂ‘ﬁﬂﬂﬂuiﬂ5ala85
4

3 1 4 ]
HAZINGDINBUNAADS 2INTUATN OK AdzUN 1.3

31 2.3 yamanassdennuuenldhinisiFouse USB ssuiuewdndfineu Insamesunay

4 a 4
INTOIADUNIUNDT

n’: = 9 A A o o :-:' d' 9 o a
4. niNfuszlivennuiietudy AsgUn v.4 uazzln .5 Whnisadn Yes uaz OK

AN

317 w5 uamadennudeuldidauaziFoudeiouidndn

A o a & P P o a
5. Tdsunsuezisuinsanauls LIS YURIDY LAZUAAINTSUIUNS Az 2.6
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Progress Log

Bullding Firmware Image

WM file: .\bin\lejos_nxt_rom.bin

Menu file: .\bim\StartUpText.bin

VM size: 48096 bytes.

Menu size: 32527 bytes.

Total image size 80655/81920 bytes.

No devices in firmware update mode were found.
Searching for other NXT devices...

Building Firmware Image

VM file: .\binVejgs_nxt_rom.bin
Menu file: .\bimStartUpText bin
‘WM size: 48096 bytes.

Menu size: 32527 bytes.

Total image size 80655/81320 bytes.
No davices in firmware update mode were found.
Searching for other NXT devices...

found NOISY Bluetooth address 001653007848
Waiting for device to re-boot.... . . . .
still waiting.. . . .

31 2.6 uerasmsAndaflSunaiues LeJOs NXJ

é o = q’: o 4 d A 9 =Sy [} = q’:
6. Wenimsaadudsuulsyeuaved wSaSoudes sxlidenuniuindsenisaada
s & ] q’: 1 [ < n’:
Asuns midnasinselu 1¥asy No vinludsamsnsensu Yes mandosnmsaasuilsuuas

1 [y g o o A [y o
TmilidueudndfinouTnsamesaidu dagilf 4.7

. - A B ,v — R — 8
31 0.7 urasmsfadail Sunasues LeJos NXJ aFaSoudon
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' |
21515 UNe9 Netbeans 110 1991459351 LeJOS NXJ

1. N5AAAI Netbeans

1.1 a1l Indalysunsuldnn http://www.netbeans.info/downloads/index.php ﬁ'\‘igﬂﬁ

f.1 r1‘}3!’ click ﬁﬂu Download NetBeans IDE Wolden mirror site 1UMT download

NetBeans IDE 5.5.1 Download

NetBeans 5.5.1 Installer

(Windows /English (en))
netbeans-5_5_1-windows.exe (53.7 MB)
MDS: 69302529ea58b713¢c87d1460bedSf75¢

(__ ~Pownioad-NetBeansiDE- )

Other Systems & Lanquages

317 a1 uarasnihoelumsaiad InaaTisunsy netbeans

A 4 v W ¢ ) a2
1.2 1{f9 download 1&5 911872 92 14 14d netbeans-5_5_1-windows.exe 31 3101 ufAa 69
T1l5un33 NetBeans 5.5.1 Tay double click 71 W8 netbeans-5_5_1-windows.exe Tdsunsu

Installer uerAsdonuAousy Azl A.2 click i Next tie l1nihae Ty

(7 NetDeans IDE 5.5.1 Installer

Welcome to the tnstall Wizard
for NetBeans IDE 5.5.1

The tnstall Wizard will install NetBeans IDE 5.5.1 on your computar.
[ To continus, thoose Next.

319 a2 ugasdonrudeusy
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1.3 100N T accept the terms in the license agreement ud7 click Next e Junihae 1y #a

¥ INetBeans IDE 5,51 Installer

Plaase read the following license agreement carefully.

NetBeans Version 5.5.1

;{'.»

oS R

Please review the complete list of open-source licenses
governing software Included In this software. They can be
found in the THIRDPARTYLICENSE 14 file,

Please review the list of ibraries and licenses provided
for use and redistribution by other partles. These libraries
are redistributable subjectto the conditions in the
DISTRIBUTION.td flle.

This license file cantains five distinct licenses.

LICENSE #1: The Common Development and Distribution License
| (CDDL). Yersion 1,0 covems vour.use of:

IR

@ | scceptthe terms in the license agreement

Y | do not accept the terms In the license agresment

51 a.3 namanthseuaauionlvyse Talsunsy

[ 3 1
1.4 Tsunsy Installer 93 1¥i5152Y path Nis1809n15AAR NetBeans 1¥151521) path #

v 3 T 1
159999M35 #9317 1.4 1IN click A Next 1o lindhae Ty

f" iNetBeans IDE 5.5.1 Installer

Click Next to install NetBaans IDE 5.5.1 to this directory, or ¢click browse 1o Install
to a different directory. You must choose a new or an emply directory where you
have write permission.

Directory Narme:
]_gf_lProgram Flles\netbeans-6.5.1

g T
¢ Cancel

T I Y
519 a4 uaaandoo g 195z path idesmsdade T sunsy
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1.5 Tlsuns Installer 9219311 JDK 5 130 6 filog luiniouiaziiaad path 09 JDK
finy Iug1Tusunsu Installier Wy JDK version 1.5.0_06Tunsdiiis1ad JDK 1Anaru version

rasadenld version Ms1deems1d Tasidon Browse click l Next (o luntlse'ly

£ INetBeans IDE 5.5.1 Installer

Select a Java 2 Standard Editton JOK installed on your machine from the list
below. You can pick a different JOK by typing In Its Installation directary or using
the Browsae button. J2SE JDK 1.5.0 or later Is required.

J2SE JDK Home Directory:
Jpykt.5.0_06

List of sutable J2SE JDKs found on this machine:
DAjdk 1 5.0_06 v 1.5.0_08)

51/ a5 uaaa path ¥o3 DK finvlumiosnouiunes

v b4 ' ] ¥
1.6 Tlsunsy Installer (Su@ada 115unsa NetBeans 231U path N531) ilioAnns

TsunsuasaSoudoouda click i Finish ifesn Tsunsu dagdi n.6

£’ INetBeans IDE 5.5.1 Installer

The Install Wizard has successfully installed NetBeans IDE 5.5.1 on your
computer. Choose Finish to exlt the Wizard.

NetBeans IDE 5.5.1 Installation location:
dtempinetbeans-5.5.1

To run the IDE, faunch:
dtemp\netbeans-5.5.1\bin\netheans.exe

To uninstall the IDE, launch:
dtempinetbeans-5.5.1'_uninshuninstaller.exe

TreztaliShielsd

' : 3/
U7 .6 ugasihsedionsAads T sunsuiasvauysel
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4 o a J
2. nsa el siamieannssuudauaua

2.1 K151l 1eJOS NXJ samples project Tﬂﬂl’ﬁ@ﬂﬁmg File >Open project fegdn

¢

.7 4A2¥11713 Browse ‘11]E‘J’aﬁmmia'lm%‘ﬂﬂﬂ?ﬁﬁﬂﬁamamﬂﬂMﬂ"l"i TasTisadog199

wannTulejuoudezogluTrames samples

T myproiectPC - HetBeans IDE 6.1
JEiR Edt View Mevigate Sowrce Refact
% New Prafect... CrrHeshife+N
New File... CulN

Cpen Recent Profect »
Close "myprojectPC"

Open File...

Open Recent File »

Project Group »
Set Main Project >
“myprojectPC” Properties

tave Ctrl+S
Save As...
By save al Ctri+Shift+5

Page Setup...
Print...
Print to HTML.,.

Exit

g‘ﬂﬁ .7 1aaen151la 1eJOS NXJ samples project

A [ e ) 1 Q7 1] L {
2.2 Weimsidlaldsieadiednenuni Iswadieg1e dagilii a8

N
127 samples

ﬁle Edt View (Fevorltes Tools Help

eaark - @ ﬁ pSearch @Fdders .- @Foldasyn&

Address | i Cillsjos_nxfiprojects\samples
PR £ 10 St 5 FInTservoTest B project
Filecand Folder Tasks -~ & §BTConnectTest FdPerformanceTest ) build,xm!

§Poters §iprTest B mankest.mf

3 Make & ey Folder lBTReceive EpiotTester [&)samples.prope:
e Pwu.:il:lsh this Folder to the §3BumperCar $HRCNavigator

4 ColorDetector $IRCKEmUlator
§53 CompassTest $BRCEMMTest
B DistancaTest $BRCHMUxTest
I G2 DL Test $BRCRPortTest

$€l ExcentionTest RIRCRRemote v

4 o o ' =] dda & o 1
3141 A.8 uaAINT Browse luldaduniislainnesndadadatalisien

EZ Share this folder

Dther Flaces - 0

F4 v
2.3 viniuiinisadalusiealviTaens'1u4 file > New Project >Java>Java

Applicaton uﬁ'aﬂﬁnﬂn Next ﬁﬁg'ﬂﬁ f.9



¥ Project_name - HetBeans IDE 6.1

| Edit Aled Navigater Source: Refactor |

ﬁ MNew File... Ctri+N Ly
3 |

Open Project... Clrk+Shift+0
Dipen Becent Project »

Close “Project_name"

Open File...

Open Recent File »
Project Group »
Set Main Project »

"Project_name" Properties-

5?‘\*‘8 Ctri+5
517 a.9 uraansadaTiswalny

z o 3 ¥ [ ¥ . . o d [
2.4 niniuliiimsdero Tosion luiild¥e1 “Project name” fvualasaness

i Tilsien wazfmuadaudena1eqfagl udndnty Finish fag1il a.10

7 Neve Jita Application

Steps Name and Location

1. Choose Project " Profect Néme: if‘m}ectxme ] ' 1

#
2. Name and Location H

; Project Locatlon: {CtVlejos_md\profects . ] W

5 Profect Foider:  IC:\lojos_redfiprofects|Projact_name }

[ Use Dedicated Folder for Storing Libvaries

Litwaries Fdder!l ] 3 Browse. . E

Create Man Cass [pvé)act _name,Main " ]
Set as Main Project

¥
i
g Different users and profects gén'share the same comgﬂatlon librarles fsee Help For details),
g
!

80

v ¥ .
317 a.10 uaasmsmsasde 1lsien
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S

14 [ 1
2.5 niniuezdsing Wswanad 113 uuny Project Asgildi .11

:Proju ;l:T, Files IEServices 1'_-
I}]& myprojectPC g
] [;‘ﬂb myprojectPC_all B
] [}]# pcsamples

g & j -

|| @-E@ Ssource Packages
E-C@ Test Packages
§-C@ Libraries

E-}@ Test Libraries
Egm& robotproject

Eﬂ& samples '
9 3

— e -

g

= 3

¢ . P
3N a.11 uame Ty siadignadredu

14 ] ]
2.6 nmiuldhnmisadnuni Tsioafias1e'ld iden Properties > Libraries > Add

o 4 . SO . IO N T
jar/folder udmsiia classes.jar megiu .\lejos_nxj\lib mgﬂw .12

Project Properties - Project_pame

Java Platform: I.'DKI.G(DefM) [.;] s Platforms.. .,

Ubraties Folder:[ I l g DOV ”I

Compie | Run | Compila Tests | Run Tests)

A M RAPATRS R W 1 - T - -

|#) Freechart-1.0,11.Jar |4} ptocks. il @ Use Relative Path: I%

[ #) foput.jar &) servist.5d i
|4) iText-2.1.3.ar (4} 3oystick.jar [ ) substanc LidMbiasses o I E
[] fcommon-1.0.14.jar () toots.ar (&) swtgrapt] O Use Absokte Path: .
|4 Freechart-1,0.11-experimental.jar [ 4] Junk.jar [c:Vletos_nxfiib\classas.jar. | -
[ 4] fFreechart-1.0.11-swt.jar |4 pecomm.jar |t
<] e me e L P (> J
File nama: [classes.jar ] I s 0P l n |
Fles of type: [ classpath Entry (Folder, ZIP or J4R fie) v]  leaSeoselad

| ]

Complle-time Itraries are propagated to &k Bbrary categories.

Builld Projects on Classpath

3N a.12 wrasmistivunataasluTysion

2.7 $1n159514 Java Package Tavnanun Iawmes Source Packages >New> Java

Package taziinsld¥ovnd Java Package Tunti ldven “org.me.myproject” ﬂwsigﬂﬁ f.13



1 4 ]
2.8 91nURINITT$19 Java main class Tasnisadnud Package org.me.myproject

>New>Java class uazﬁmws‘ld%amm Java class ﬁluﬁﬁﬁl%ﬂ?ﬂ’h “HelloWorld” ﬁ'\igﬂﬁ .14

¥ braject naime - Netiteans IDE 6.4

jFls Ed® View Navigate Source Refactor Bukd Run Profie Versioning Tools Windo Window

.

A i,

el L EEY LY Jlecreeo b Y

iProf.. 4 x|:Files |iServices ¥ ...ava [ PCcontroljave = | [ Camera_Controliava »
-8 myprojectPC : *‘““] vesn [
:'b myprojectPC_l 1570 B-M-a% E.i
?..
!
| Java Class..,
} £ Folder...
. Java Interface...
: PCcontrol.java - Paste ¥ %J::elF 808 ‘
| Mombors Yiow Delate Dekte | o« |
E«& PCcontrol :: JFrams Renane.. Entity Class...
-0 PCcontroI() Entity Classes from Database. ..
i Reverse Engineer... |
" P othr.. |
1 ) hltCO'anef“O Compde Package  F9
I € ButonioAdionPerfd  Local History »
i -& Buttont1ActionPerf
+ €9 Buttont2actionperfd__ 19% yous 4
L&D Button 4actonPecormed(ActionE 1689
-@ PuttontSAdionPerformed(Actiont (L1 | 1 cqq
- S
2N PRSI hk—-] @ ol R

gﬂ‘n f.13 uﬁmmsﬂ%’nmmmﬂmﬂ

1 4 [ 3
2.9 nimiuwhnisud lvIdamoluWd Helloworld 1ifludsgilf 15 lemamouns

iprof.. 4 x1iFiles [:Services ...ava [ [ PCeontrol.java x | [#] Camera Contrdl.java x
A ”
§-& myprojectpC source | Desigr T I - QA - Q%gi
@b myprojectPC_all 3 [y 1]
G- posamples 1671
lé b Project_name 1672
} é @ Soun:e Packages 1673
Java Package...
z é @ Test Packages 23]
H é & Ubraries Find... Ctrl+F
i
§ & -Gl Test Liraries Cut Ctri+% {5 srame Form. ..
q; robotproject Copy aric | CRFolder...
o Paste ctriev | BB JevaInterface...
F Detete Delste [[] panel Form...
Refactor » Entity Class...
Entity Classes from Database.,,
Reversa Enginser. .,
Other...
Compile Package F9 ﬁ
Local History »
<No View Avallable
Tools »
PA-1-1-)
1689
1690
1691'/,

517 a.14 uaaamsadrenaralulisin

Bruvss 1dsunsy

package org.me.myproject;

import lejos.nxt.*;

66
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public class HelloWorld {

public static void main(String(] args) {
System.out.println("Hello World"):;
Button.waitForPress () ;

}

317 n.15 uaasmsud luTaan1olu IWg Helloworld

1 4 [ []
2.10 NINYUIINT copy IWa%e build xm! 1ndaee1a1uswafi laidlal3lude 1.1 uas
1.2 1138 I aumes Source Packages ﬁﬂgﬂﬁ f.16

Fle Edt Wew Navigate Source Refactor !

) P ol Rl PO 0

% - ,‘:. :;jéfi‘l_es I’.Services

&-& myprojectPC_all

@% pcsamples

2-& Project_name

E&@ Source Packages

5 EJ@ org.me.myproject

§ b [ Brielloworld. java

m@ Test Package:

E-}@ Libraries

E}@ Test Libraries

E;]& robotproject ;

E& samples
B0 Bluestats
| &-FQ <defaut gickage>
L - @esest
&}@ BT
@-C® BTGPS
e ) "B:fecell\:e

317 016 A3 copy IHa%e build xml 91nd30d 18 Telsieai 18da 15 1uds Tnaimed

Source Packages

2 , 2 \ o 2
2.11 :MTuda' W4 build.xml Yumwdaviimsud ludail

e ulasudeniiu <basename property="program" file="."/> Lﬂu<property

-1t

name="program" value="HelloWorld">

® NS property:
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<property name="class" value="org.me.myproject. HelloWorld">

o

} 4 [] ]
o  91n1uludIu link target, Wlouvssianlideniu

<arg value="$ {program}"/> iy <arg value="${class}"/>

212 gan1u¥1n135 copy

INEERELER sample.properties vnivaney

...\lejos_nxj\projectsisamples 11138 Irlaines 1Usienfifrdawiann lufifide ane 4o

Project_name ﬁﬁgﬂﬁ f.17

——————

B b i - - it

barch [yroiders ({77 () Pokdersymc

s
CoiBluestats YANXTServoTest & profect
CApTConnectTest  EelperformanceTest d} buﬂd xm!
EIBTGRS §APFTest ;

¥ 2BTReceive ElpictTester

f23BumperCar GIrRCNavigator
FAColorDetector SRCXEmulator
A CompassTest FARCKMMTest
$DistanceTest BIRCMUxTest
RoiDLTest IRCxPortTest

YA ExceptionTest EIRCKRemote

' Eﬁs«m [ rotes - (05 ror e

AProject_name

@ -
buld.xm!

‘ XML Docment
4KR

‘lJﬁ .17 UDAINIT copy "lmla‘nm'am sample.properties vinvlanes . .\lejos_nx;j\

projects\samples ‘11138 THame { T sinfidrd et

4 @ o ot ° 4 1 y 1 &
2.13 liodeamsdn Inoa W I Sajusud iimsisoudeseniejusuduaziaies

a 4 3 o 1 o a ~
AvuNAABIAUTIY  USB nie ugys sinmiuldinsdavuoud udinisadnuaii

. H -] =t 4 P 1
build.xmI>Run Target>uploadandrun 31AUUNIN ppload duSeeziideanuiuiiuny Output 21

“BUILD SUCCESSFUL” aa31#i a.18



Rk E’ﬂ% pcsamples ki
H L83
E H& Project_name =3 8 /
i *
|| EEP Source Packages 9 !
H H * .
E@ org.me.myproject , 10 Ganthor Inpi:
H B o *
4 i [} PHellowarld. java i 1 /
E!ik 41 12 public class He.
E}@ Test Package s
G- Libraries  [RiS S
-GR TestLbraries Debug :rarget M cean
|&-& robotproject Local History " complie
E-@p samples | oy Ctrix | link
{bulld.xml - Navigator|  Copy Ctr+C | upload
JAnt Targets Delete Delete | Advanced..,
i% clean Rename
B, comple
! ?d tink Save As Template, ..
B, upload [ns ]
{;Output - JavaApplical  To0ls 4
» init: ] Properties
'. deps-clean:
clean:
] BUILD SUCCESSFUL (total time: O seconds)l
{
3

UM a.18 uaasdeamsdn Tnan s ludajuoud

} 74 d' (¥ g a d
3. msﬁiniﬂsmmwawmmizuuﬁaﬂaummai

3.1 vhmsadelusonlniTaoms1Ua fite > New Project >Java>Java Applicaton

18andN1fy Next fagifi a.19

T Project_name - NetBeans IDE 6.1
Edit View Mavigate® Squrce Refactor §

oA Sty
T3 New Fie... Py

48 Open Project... Ctrl+Shift+0 E]
Cpen Recent Projact »
Close "Project_name"

Open File...
Open Recent File »

Project Group »
Set Main Project »

"Project_name" Properties

[Py

Save Ctrl+S B
317 a.19 wamsmsada lusialui
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z o ! [ ' . o o
3.2 miulihimsld¥e Tusien lufifiléFed1 “Project PC_name” drvualaSane

SunuTdsien wazfmuadudendrendegil udandnily Finish fagUi a.20

P Heve Java Application

Steps Name and Location

1. Choose Project Project Name:  [Project_PC,_rams| ]

2.  Name and Location
Project Location:  [C:\lejos_nxjiprofects | faBrovse ol
Project Falder:  |c1\iojos_nfiprofectsiProject_PC_name ]

, [ use Dedcated Folder for Storifg Liraries
Libraries Folder; [ ] {m,.& ;;SOM

] et

Differant users and profects can share the same: compdation Woraries (see Help For detals).

H

# [ Create Main Class [protect_pe_name.Main ]
Set a5 Main Profoct

|

O [ K]
311 n.20 uaaensdsye Tlswnuas Taisane iy Tulsin

t 4 . ]
3.3 ninvuidthinsadneiTdsieniiadrel’ iden Properties > Libraries > Add
. Y 4 ¢
jar/folder @M Tau 13l
LA o
® pccomm.jar LD pctools.jar cmag‘lu .\lejos_nxj\lib
L

® bluecove jar °1N‘t'lgiu..\lejos_nxj\3rdparty\lib

¥ ) v ¥ } 4 [ 1 4 9y

dievimsmin lausSianuaiiugr melulys Teafigdrsduiuannsoadie

java class 1dannlnd
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4. auilszneuveanta 191154053 Netbeans

7 mypro;ectPC NXI 1 Nc!dens DE 6.7 - .
Ele Edit View Navigate Source Refactor Quid Run Profle Versppring Jools Window Hslp

NEES X WED @ [Fwe W TW P BB

roject ¢ B

- & myproject_NxT « t B K - 'Q'@,E. B P A2 OB L

--& myproject_NXT_1
b m JectPC_NXT_1 k package myprojectpc; )

& % Source Packages

g} mypro)ectpc

i~[@ Pccontrolfava
- PCInkerface.java

-t

import java.io.DatalnputStreeam;
iyport java,io.DatalOutputStream; %
import java.io.IOException;

O~ Ot WO

§

!

g D PClnterfacs_tf_|nput.ser 3 import java.io.InputStream;

f PCMessage.j-gv; import java.io.OutputStream;

! B PCReceive.java B import java.text.SimpleDateFormat:
% [ 9 import java.util.Date:

PCSend.java

[
(=]

i

L.

8

i . . . :
i @ Tex ok jave ’ import java.util,logging.Level;
@ myprofectpe.image

é_ 11| import java.util.logging.Logger:
12 import .le . pc. conm . NXTCorm;
@&-E8 myprojectpe.image.[Originals] , Tpor Jos.p T
GB’*@ TestPackagas 13] import lejos.pc.conm.NXTCormEXception;
- 14 import lejos.pc.comn.NXTCormFactory:
. 15 import lejos.pc.comm.NXTInfo:
Navigat
ﬁembersVlew ~ 16 import javax.swing.JOptionPane;
4 ’
-3 PcControl 17}/
b @ concelPlot() : boolean z 18 " ~

L]

~ (@ closeConnection)

- @ confirmMsg(Strimg msg) : String e ’ Gx i b

-~ () createConnection{actionEvent evt) : boalear ; e -

- @ plot(String msg) : bodlean Creatad dir: E:\Master\Project\backup project\Copy of nyprojece |

- [ ConnHandler : Thread Building jar: B:\Master\Project\backup project\Copy of myproject
- * Copy libraries to K:\Master\Project\backup project\Copy ot nypro

= [3 chacount : int To run this application from tha command line without Ant, try:

- [ chckeount : int {7 [jave -jar *X:\Master\Project\backup project\Copy of myproject ]
P Wy wee & am s am Jar:
¥ : FUILD SUCCESSFUL {total time: 1 second) %
h 2 & o | 3K Ol s 7, 20 s,

R _ £

3UM n.20 daulsznouveanthaie1Usunsa Netbeans

L 4
ni11A19T15un 53 Netneans sznou lUdsaurlszneundng 4 daudaotu aeil
1 ~ < ] 3
1. w1 Project uaaslysinfidlaldarn uiaine aane wazdawsznounns
vo11Us519n TaslisuuD U tree
2. #1819 Navigator uaassiemsvesnaauiavesnaiafisidaudaldan iy
method, attribute (HuAu
3. whaa Source Editor
Y 1 0 ] o
4. MU Output LaAINaN1IN UV TUsUNTY 1 wan1saou Tnd 1Usunsy

doRanata (error) ¥04 10sunsuvazsu Tsunsy Wudy

)
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M3 .1 seunsanlslunmsndenveunaziisnys
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9

4

o o o

Y5 AAUNNA

o]

10104012040616202626499

1020004446342024261400099

103634424030120406199

1040004446361400099

1056000026202046499

10660000262020499

1076140200103244463624299

T |mimjOolaolwm ] »

10800040262646099

—

10920403034244499

—

11040606344240399

1110004022260226499

11200046499

113040032606499

1140400646099

1154020010324446361402099

11604004061420299

1174020010324446361402077436499

118040040614202426499

1190324446342220120406199

1200060303499

12100032444636099

122000234626099

123000432646099

124006477046099

S IX|lgE|l<<iclm|lwn|m|lolwmlolZ2|2]l]R

125003260323499
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MINN 4.1 (AD)

DNYT MAunna

Z 1260060046499

1 12741606499

2 12801204061046499

3 129012040614222426344240399
4 13044402001036399 |

5 1310444634202006099

6 132032242634424030120406199
7 13300600499

8 134422201204061422203244463422299
9 135614222012040616344240399
0 1364020010324446361402099

13743232444432399
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